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Config | Settings I

No devices identified.

Initialization Complete.
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Instructlons Hilinz applications automatically detect valid, node—locked licenses lic) residing in the local Milinx
e Copy License button to copy a license file into this directory.

enwronment valables below. (Linw: users will need to make these zettings outzide of this appllcatlon)
Examples: 1234@server,C¥licenses¥Xiling lic (iindows) or 1234@zerver:fusrflocalflexlm (Linux)

RILINAD_LICENSE_FILE I Set
LM_LIGENSE_FILE I Set
Feature S/ or | Wersion |Expiration | License Count Licenses | Information i’
IP Gore | Limit Date Tvpe Ih Use

‘Web_Package S 201209 |Permanent | Modelocked | Uncounted emb@arch.cz.titech.ac
xpz_usb_host IF 201012 | 30-jan—-2016 | Modelocked | Uncounted License_Tvpe:Hardwa
xpz_ushZ_device vz |IP 10 30-jan-2016 | Modelocked | Uncounted License_Tvpe:Hardwa
xps_ush? device_»1 |IP 10 30-jan-2016 | Modelocked | Uncounted License_Type:Hardwa
xps_ush? device P 201012 | 30-jan-2016 | Modelocked | Uncounted License_Type:Hardwa
s:ne nart1ARAN 1 TP 1in Hﬂ—lanl—7ﬂ1ﬁ Modelncked |1 Ineoonted | irense T\.'nP'Harrhn; hd

— Local Sy=tem hformation

Hosthname: firearch
Metwork Interface Gard (MIC) ID:  005056-00008,005056:00001,001 37235{b60
C: Drive Serial Number: 3de2elce

FLEXID Dongle ID:

About | Befresh I Cloze

MEARARHD AT L]
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ISE Project Navigator M#EE, AT TV +DFRIERL
ey, — e
+ New Project RE2ZEV)vy

&

u

EZISE Project Mavigator (M.81d)

e =10l x|
File Edit Wiew Project Source Process Toole  Window  Lawout Help
ID3E@ . lxD ix[wallrr@2R 2RAI=E Dollelr= L9
Start «+08 x

Welcome to the ISE® Design Suite
Project commands

Project Browser.. |

Mew Project.. I an Example.. |
e

— Recent projects

Double click on a project in the list below to
open

1
FFGA
FFGA &l

— Additional resources

ISE Dezign Suite InfoCenter

Eey Mew Features in Project Mavigator
Tutorialz on the eb

Design Fesources

Application Motes

Consale «+08 %
=
T _>|_|
Conzole @ Errors | _ﬁ Warnings | 28 Find in Files Results
A4
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JODx O RTFETSHTALIRMNIEIRE

« FSATIFZESATE#RHWNSDT,
Location |Z, Z:¥Emb¥ise #1857, Name IZ, main01 Z{EE9 5.
+ Next RE3%I1)v9

[ES Mew Project Wizard x|

Create Hew Project
Specify project location and tvpe.

—Enter a name, locatio

t for the project

MHarme: ImainD‘I

Location: IN:¥Emb¥iseFmainD1 — I
Work ineg Difsctory: IN:¥Emb¥ise¥mainD‘l/ _I
Description: e ————

—aelect the type of top—level source for the project

Top-level source type:

|HDL =l

—~
9
’“@ Mare Info | G&xt> Cancel |
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9 HFPGAZFED

+ PRI HFPCANIEIEGELIEHEICIEET 5.

=JL
axX AE

- EMn, All, Spartan3E, XC3S500E, VQ100, -4, XST, ISim,
Verilog, Store all values, VHDL-93

+ NextihA&E7')vy, FEFEEME T Finishik2%91)v9

2= Hew Project Wizard I

Project Settings
Specify device and project properties.

Bl

—Select the device and design flow for the project

Property Mame | Halue

Product Category / Al \ |
Family / Spartan3E \ =
Device / HC3E500E \ =]
Package / V100 \ =]
Speed / -4 \ |
Top-Level Source Tvpe HIDL

Synthesiz Tool

HaT WHDL erilog!

Simulator

ISim OWHDLA\erilog)

Preferred Language

Werilog

Property Specification in\roject File

Store all values

0 [K0 KN K4

Manual Compile Qrder \

-

WHDL Source fnalvsiz Stancﬁ@l

WHDL-93

Kl

AN

N\

Enable Mezzage Filtering

—

ENEH Project Wizard

Project Summary

Project Navigator will create a new project with the following specifications.

Project:
Project Name: mainOl
Project Path: M:%Embhise\main0il
Working Directory: MN:%Emb'iseimsain0l
Description:
Top Lewvel Source Type: HDL

Device:
Device Family: SpartaniE
Device: xc3=s500e
Package: w100
Speed: -4

Synthesis Tool: ST (VHDL/Verilog)
Simulator: ISim (VHDL/Verilog)
Preferred Language: Verilog

Manuzal Compile Order: false
WHDL Source Analysis Standard: VHDL-93

Message Filtering: disabled

Property Specification in Project File:

Store all values

Mare Info |

< Back ‘ ’Oance\
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Verilog/—ARAI—F DB
e e — R —
+ Project -> New Source #:#EiR

+ New Source Wizard [ZT, Verilog Module ZERL, 771/L % main.v &
AHBL, NextiRBZ2 #0109

ESISE Projer . Navigator M.81d} — N-¥Emb¥ice¥main01¥mainDi xise

=18l x|

- A
Tile Edit We Jrce Process Toole Window Lavout =¥ New Source Wizard >I(I
IMaEm o D O X[ & | =]t 'ﬁ% RAlE=Easlsels =219
Design eO®x Select Source Type
[ | View: & {8} mplementation 4 Simulation Select zource type, file name and itz location.
&l Hieramhy -
E] main01
E £ xo3s500e-4vql 00 - -
S| Unassisned User Library Mo [ IP (CORE Generator & frchitecture Wizard)
al Empey view (o] Schematic

: o \
| Tioe, Yot con add et o E Uzer Docume
[ © project using the toolhar at left, ? J
| Commands from the Frajedt mer, ierilog Module
n * and by using the Design, Fles, and

© braries pancis m ‘._.fer||0g Tezt Ej
e =l Module Fil -
| B2 Ma Processes Runnine VHDL Library Lile name:
g | No singls desien moduls is selsoted |
% % Desien Utilities WHOL Package
B
% a| WHDL Test Bench Lomat

ocatior:
'E | Embedded Processor =
|N¥Emb¥ize¥ main01 .

=5 Start B3 Design | ] Files | D) Li 4]0

Console

08 x

=

¥ Add to project

KT — »|‘| - More Info |
Console [ @ Errars | 1\ Warnings | 16 Find in Files Results
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Verilog/—ARAI—F DB

- Define Module TlIX, A[HANETI(Z, NextiRE%x01) 99
« BIYMNRIREND. FinishirkZE91)vsH

x| |
Define Module Summary
Specify ports for module. Project Mavigator will create a new skeleton source with the followineg specifications.
Maodule name |main Add to Project: “es
Source Directory: N¥Emb¥ize¥mainll
Fort Mame Direction Bus MSE LsE ;I Source Twpe: ‘u’eri_lng Module
input LI 0 Source Mame: mainy
input =IO Module name: main
nput =10 Part Definitions:
imput =0
input 3 O
input 3 O
input 3 Im|
input B im|
input =IO
inpurt =IO
it =0
input 3 O
-

More Info |

More Info |

< Back Cﬂnisﬁl Cancel

i
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Verilog HDLD#R5E

- module main Z#RET 5.

=ISE Project Mavigator {M.81d) - N-¥Emb¥ize¥main01¥main01 xise - [main.v] —of x|
Eila Edit Miew Project Source Process Took Window Layout Help :IEIEI
IDeEd s b bxwal 2R ~RBAlm=sT0c(l#elez L9
Design 4= 1 timescale 1lns / 1ps
View: (% {F Implementatit™ = 2 SEASISERR PRSI RSP SEE AT
Hierarchy — 3 // Company:
4 // Engineer:
=] mainD1 - 5 /7
= e ch;EDUef_dvqu & // Create Date: 15:54:06 07/24/2011
o [l main mainy) = /7 Design Newe:
- g // Module HName: main
— g [/ Project Name:
A i0 // Target Devices:
% 11 // Tool versions:
12 // Descriprtion:
- Gd IR
% 14 // Dependencies:

4 | 15 //

16 // Revision:

| €2 MNo Processes Running
17 // Revision 0.01 - File Created

a0
21
42
&3
213
&5
£ B
a7

NN NN

module mwain (ULED
1
output [3:0] ULED:;
azs=sign ULED = 5;

endmodunle

% Pracesses: main | 18 // idditional Comments:
Design Summary.Reports 18 S
Design Utilities 20 SSAISS AR RS R RS RS SS RIS SRR
User Constraints 21 module main(
Synthesize - KST 2z 1:
Implement Desien 23 |
Generate Programming File 24
Gonfigure Tareet Device 25 endmodule
Analyze Desien Using Chi+ 28
KT IS |
= Start 2 Desien | [] Files 4|» mainy [Z Design Summary
Console 05 x
(i INFO:HDLCompiler:1677 — Analyzing Verilog file %\ "N:/Emb/ise/main01/main.v\"” into library work -
A INFO:ProjectMomt: 656 — Parsing design hierarchy completed successfully.
Started : "Launching IZE Text Editor to edit main.w".
Launching Design Summary/Report Viewer... _lll
>

GConsole | @ Errors | 1y Warmines | i Find in Files Results |

Ln 23 Col 1 [ Werilog 2

RRIEXRZ FHRIFH FREBREDEAAH AT LA
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UCF(User Constraints File)D B0

+ Project -> New Source #:EiR
*  New Source Wizard IZT, Implementation Constraints File Z:#iRL, 7
74)L%& main.ucf ZA AL, Next R %0y 5

. HIUNRTEND. FinishRav &5 vY

EE Hew Source Wizard x| EE New Source Wizard

Select Source Type Summary
Select source type, file name and its location. Project Mavigator will create a new skeleton source with the following specifications.

BMM Fils #dd to Project: ‘Yes

oEocope Definition and Connection Filg Source Directary: N:¥Emb¥ise¥main01_ )
B iTmplementation Gonstraints File > Source Type: Implementation Constraints File
el (CORE Generator & &rchitecture Wizard? Source Name: mainuct
MEM File Azzociation: main
o] Schematic pr——
=] User Document = )
Verilog Module |main.ucf
Iy Werilog Test Fixture
s ® Lozation:

Mg WHDL Module
[ VHOL Library [N¥Emb¥ise¥mainDT [
[F] WHDL Package

% WHDL Test Bench

| Embedded Processor

Iv Add to project

More Inhfo | Cﬂext > ) Cancel| More Info < Back (Einish w—l Cancel|

e
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UCFDENEHRE D E(E

+ Hierarchy @ main Z® +
* main.ucf NENS.

=)y

+ mainucf D ETFTILY1)YY, mainucf DMRETRIRELS.

:Enl File Edit “iew Project Source Procesz Toole  Window  Lawo

IN&E&|

Dezign

|J_| dt

X |0 | o=
+0O0&F X =

2 24

1

[ | View: & {5} Implementati o Simulati 5=
L5 Hierarchy f—
G o 3] main =

SE B e BsB00e—dvg 100

it ﬁnﬁ main {main.y

A
4 “
= %

ﬂEiIe Edit Wiew Project Source Procesz  Tools

D23E&: % X |0 o |
Eegign +~0O0&8x [
[ View: (+ {5F Implementatit™ 38 Simulati
% Hierarchy o
i-= > '@ﬂ maindl -

Bl £F xc3s500e-4vq] 00

EISE Project Navigator {M.81d} — N:¥Emb¥ise¥main01¥main01 xise — [main.ucf]

_(oix
Fil= Edit Wiew troject Source Process  Tools  Window ayout Help - s
[ File Edit Vi P S P Tools  Wind L Hel == x|
I ls ooxwel lrrdn ARl aciler]lr=L]IQ
Dezign +08F x = 7 |
[ Wi fs Iﬁl}lmplementatr Slmulatl =
cEl Hierarchy e
Hﬂ E! maindl -
25| B £ xc32600e-4vq100
o Bt []eff: main {mainy
—_— Ea mainuct o
& »
A
P “
- A
s
< | =
p | €2 Mo Processes Funning
% Processes: mainuct I
+ -
Ert ‘g‘ User Constraints
x
7
T — |
'w% Start  EE Design I [ Files 4|>|l mainy J Z Design Summary |®
Console N ——— +0&F X
Preparing to edit main.ucf... ;I
Started : “"Launching ISE Text Editor to edit main.ucf”.
-
4] | >
Conzole @ Errors I_g Warnines | [ Find in Files Results
L1 Cal1 [UCF 2
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UCFDi#m&

- UCFEZERDRKRIZIRELTRE,
REIX ICtrl + S1DLa—khvbk, £1=14, File -> Save ZiER

ESISE Project Mavisator (M.81d} — N:¥Emb¥ise¥main01¥main01.xise — [main.ucfl

_(ol x|
[ Eile Edit Wisw Project Source Process Tools Windguess @i Do _|&] x|
IREEEIEE xwa AL o 2Rl elleoe]lrzele
Desien =1-F T —N
& Wiew: & {8F Implementatic™ [ Simulati g~
(Z] | Hierarchy =
o | 18] main0l
‘EE B £ xc3s500s-4vg100 <
& & [V main (mainy)
E o P mainuct =
£
& *
= *
Y T
| P2 Mo Processes Funning
% Processss: mainuct
= 8 User Gonstraints
R
A
< | |
[ Start | B3 Design |11 Filss 4| » main [ = Desien Summery 1= mainuct (x|
Gonsole 08 x
Preparing to edit main.uct... =]

Started :

4

"Launching IZE Text Editor to edit main.uci".

7

GCansale [ @ Erors | £y Wamings | b Find n Files Results

Ln1 Col1 | UCF //;l

RRIXKYE FRIFH FREBREEMEARAAS AT L

EE 100l=

o o |

wingow  Layout  Help
- b od
> JJ ‘;-!-J & - El rey

= A AlC

F
Il

il |

5

L

Y T R o

NET ULED<0>
MNET ULED<1>
MNET ULED<Z>
MNET ULED<3>

LOC="P32";
LOC="P33";
LOC="P34";
LOC="P35";
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IR & R

- main (main.v) 21)v09 5L, Processes [CIEE MERIRIND.

- Processes: main M5, Generate Programming File 47 )L7)v), iwEBEMZEIRO
%.

+ LIEB<T %<&, Generate Programming File D EIZERDF oy oM RRSNNIEHLL.

- i E main.uct o
=| Do Dl diewr COOJELL QULPLE CIUGERN U0 N Loy g
(IRN=A5 =8 || & X @ a| »F o4 A
Jesien +OEx g 1 NET ULE P “
[ Wiew: (v ]:l‘:j:[ Implementati’™ & Simulati | z MNET ULE — %
E[EJ Hlerarchy - 3 ﬂii Eii - g
Hlﬂ ----- '-Lcj mamEI'I - B J | LI
| el > - . o | P2 Mo Proceszes Runnine
" - E Processes: main |
£l . EI: = = Dezien Summary.Feparts
A Fa Dezign Utilities
Iﬁ % ETI: Uzer Gonstralnts
= “ M

% R
. < | _'I t- Mg Oonfigure Target Device
> L b Firessne R [& Bnalvze Desien Using Chi
% Processes: main |
5{: = Dezien Summaty.Reports _‘I—I
il =2 Dezien Utilities 'H'E Start G2 Desien | I Files 4| }l l mair.y J X Design Summ:
5{: [} Uzer Gongztraints
- . P2  Swnthesize - K'ST Conzole
=N I e FRunning bitgen. ..
Comrand Line: bitgen —-intstyle ise —-f main.ut main. ned
Process "Generate Programmning File™ completed successfully
] I
SN

E‘ Start B2 Design | T Files ‘l}l I —— [E| Console @ Errars | ;\n Warnings | 1 Find in Files Results
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FPGA/PROM~DEZAH
\__, \,—\_7 g G gy
- Digilent Adept Z#CEl, FPGAE D Browseha2&91)v7.
- Z:¥Emb¥ise¥mainO1¥main.bit %ER
- ProgramR A2 %&91)v9 93 BE, FPGAIZERIRRIEHRMNEZAEND.
- FPGAIZIER MG DT, BRZUISHLEIRIFEHRMNAEZTLESD.

- FAEEMDOPROMIZEZAL L, EREABICEHTZDEREFEHRN
FPGAIZO—K&Eh 3.

A% Digilent Adept
JTAG-USB I Comnect: [Tae-use cate =l

Product: Jtag-USE Cable

mainO1.bit [ZIE D2, DAN R LTI HEIERIFEHAEIASN TS,

RRIXKYE FRIFH FREBREEMEARAAS AT L 57




Verilog HDLD{E IE

+ 244TE®D ULED =5, MIEZZERELT, EDLIGEENEESHINHLTHS.

a0
21
42
&3
213
&5
& B
a7

NN NN

module mwain (ULED
1
output [3:0]
assign ULED

endmodunle

TLED:

QEHTRRT DL,
assign ULED = 4'b101; &73%.
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LTIV E B (AND[EER EORIEIER) D151

- FDOHIERFBRIZ,

Z:¥Emb¥ise¥main02 O7A IR E1ERR
- main.v & main.ucf ZRIERIZA AL, R/REERL, FPGAIZEZIALT.

+ RAYFZEHLT, LEDAED KIITEILT HhFE

module main(3W, ULED
1
input [Z2:0] 23TW:
output [3:0] ULED:

wire swld = ~3W[O] !
wire swl = ~3W[1]:
wire sw2 = ~3W[Z2]:

as=ign ULED[O] swl & swl:

az=sign ULED[1] = =wd | =wl | =wa:
assign ULED[Z] = 0O:
assign ULED[3] = 1:

encinodule

4$ea‘

RRIXKYE FRIFH FREBREEMEARAAS AT L

o -] m N & MNP

NET
NET
NET
NET
NET
NET
NET

e
ALy

EKS)

TLED<0O>
TLED<1>
TLED<Z =
TLED<3 =
Al<0=
A< 1=
0 || R

LOC="P32";
LOC="P33";
LOC="P34";
LOC="P35";
LOC="FE5";
LOC="FP70";
LoC="F71";
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o] % D e 5

+ Synthesis -XST H5, View RTL Schematic 57 I)LY')vY
- TJARYIERD main EX T ILD) YYD
- AND[EEE, OREIFE (BAN) DEMIN TSI LEHEETED.

;: Processes: main _
= Desien Summary/Reports main:1
I % Design Litilties and 2h2
£ Uzer CGonstraints L ~
= P20 Synthesize - W5T s '_J:'__
. é View RTL Schematic ULED_0_and0000_imp_ULED_0_and00001
Wiew Techhology Schema - - - -
Check Swvntax
Generate Post-Synthesis . or3b3
= B2 1 Implement Design _'"{.,':._'_"'-»._ @
# PRED Translate ,_.L.FJ e
+# P2 1 Map

B30 Plaoe & Route ULED 1_or0000_imp_ULED_1_or00001

{}D Generate Programming File

gnd

I

XS5T_GND

ULED(3:0)

main

HETEAS ERTEH FREREM AR 2T L) 61
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LEDZ RSt 48l (B R B 25D 41)

HHR(Z, Z:¥Emb¥ise¥main03 7O
- AJD CLK &, 40MHz monavwsH
- main.v & main.ucf #R9IHkICAHL,

ﬂndule main (CLE, SW, ULED
1z
input CLE:
input [2:0] 2W:
output [3:0] ULED:

reg [25:0] cnt:

always [ (posedge CLE) begin
ont <= ont + 1:;

ernd

assign ULED[O] = cnt[Z22]:
assign ULED[1] = cnt[23]:
assign ULED[Z] = cnt[Z24]:
az=sign ULED[3] = cnt[25]:

endmodunle

4@‘

RRIXKYE FRIFH FREBREEMEARAAS AT L

O 1ERL

SRIEA R, FPGAIZEZAD.

MET
MET
MET
MNET
MET
MET
MET
MET

TLED<0O=
TLED<1>
TLED<Z =
ULED<3 =
= 0=
A<l
Sl || R
CLE

LOZ="P52";
LOZ="P5357;
LOZ="P54m;
LoCc="p357;
LOZ="Fas™;
LoC="pororr:
LOZ=rpri1r:
LOZ="P36"7;
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B@REDA—ILOYT)ILTAD I led0l
ey, —~———
* File — Open Project
- Z:¥Emb¥ISE¥|cdOl¥fpga¥main.xise

- WEARLT, FPGAIZTEEIAHA.

= £ xc3=B00e-4vwql 00
=[]t MisruEME (MigruE mb.y)
clkeen - clockeen (MieruEmb.w?
reteen — rezetgen (MieruEmb.y)
=} lcdcon - miniled_con (minilod.sd

- mlcdmem — minilcd_initmem (minilcd.w)

vram — minilod_vram (minilcd.sd
E MieruEmbuct

- W y Ly
o - -~ ¥ %, ’
i T - i 3 .
o i
L L i o, o i
-] SR T 3 T Y
4= S s LA "
E L e L "
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FTRED2—ILOHLT)LTAaSTHk led0l

*  miniled_con OFIAAHE
-  VRAM_ADDR IZ 4EYFDTFTRLRZEIERE
- VRAM_DATA [Z 3EYrDBT—E2%IETE
=1L, 4E v g TiEHR
- VRAM_WE % 129 42¢&T, EDF7RLRICTEE
EBEFEEAD.

- f8l& Red, Green, Blue ZNZFNIEYLD3IEYRTE
. 8EZERRAIEE

- #HZIE, 3'blll (FBE, 3'b100 ILFHFE, 3'b000
TEE

- Verilog HDL®O#{E1O—F
wire red, green, blue;
wire [2:0] color;
assign color = {reg, green, blue};

- TRLRIFH4EVFTRE
- 128 x 128E+tI)L
- ®BEDELE(0,0), 5% (127,127) &L
T, (X, y) DEYVEILOFTRLX ADDR [&, LLIF
- ADDR = y*128 + x
- Verilog HDL M#{a—F
wire [6:0] x, y:
wire [13:0] addr;
assign addr = {y, x};

RRIEXRZ FHRIFH FREBREDEAAH AT LA

|

II."**1:1:*************t**************************************************************1

% MieruEmb Top Module
II."**1:******1:**1:**1:*1:***********1:****1:***********1:*1:**1:****************************1
hndule MieruEME (CLE, 3W, ULED, LcD <30, LoD CD, LCD WR, LoD R3TE, LoD D) :

input CLE:

input [2:0] =31

cutput [3:0] TULED;

output LCDp_Cs0, LCD CDh, LCD_WER, LCD _R3TE:

output [7:0] LCD D:

assign ULED = 0O;

wire FCLK, RST X, LOCKED; clockgen (&, 40MHz @YY i,
30MHz ™8y FCLK 4R

clockgen clkgen (CLE, FCLE, LOCEED):

resetgen rstgen (FCLE, ((3W[0] | SW[1] | SW[z2]) & LOCKEED), R3T X):

reg [14:0] cnt;

alwavs B (posedge FCLE or negedge R3T_X) hegin
if (!'R3T_X) cnt <= 0O;
else cnt <= cnt 4+ 1:

end

reg [13:0] adr:

alwavz [ (pozfedge cnt[14] or negedge R3T _X) hegin
if {'RST ¥) adr <= O; cnt[14]1 &o0v &L T

else adr <= =adr + 1: FALTWSAIZTEE.

end

wire [2:0] color = adr[12:10]:;
miniled con ledcon(.CLE(FCLE), .E3T _E(RST_X) .
.VRAM ADDR (gdr), .WRAM DATA({1'bO, color}), .VRAM WE(1),
-LCD C30{LCD ©S0), .LCD CD{LCD CD),
.LCD R3TEB(LCD_R3TE), .LCD D(LCD D), .LCD_WR{LCD _WR)):
endmodule

MieruEMB.v 66



FTRED2—ILOHLT)LTAaSTHk led0l

MieruEMB:1

andD000_or0D0_imp_and0000_orD0O0

dockgen

_andlDD0_imp__ and0DD0 ]

O TER: 2

T

resetgen

e | RAT ¥ 1
Rat el |

rstgen

COUNTER A

minilcd_con

ong
L

KST_GND

|
lcdoon

MieruEMB
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FBRED2—ILOHTILTOSTSE 1ed0?2

* File — Open Project
- Z¥Emb¥ISE¥lcdO2¥fpga¥main.xise

- WAL T, FPGAIZESAH.

—

el

= £ xc3=B00e-4vwql 00
=[]t MisruEME (MigruE mb.y)

clkeen - clockeen (MieruEmb.w?
reteen — rezetgen (MieruEmb.y)
=} lcdcon - miniled_con (minilod.sd
L e mlcdmem — minilcd_initmem (minilcd.w)
vram — minilod_vram (minilcd.sd

E MieruE mb uct

49‘
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BTRED2—ILOHLTILTaSTok led0?2

e

==z £Y N
* CEFZD#HLIO—F module MieruEME(CLK, SW, ULED, LCD_C80, LCD CD, LCD WR, LCD RSTE, LCD D);
input CLE:
. _n. input [2:0] 3
int x =0; output [3:0] ULED;
inty = 33; output LCD C50, LCD D, LCD WR, LCD RSTE:
inf COIOP - 7; output [7:0] LCD Dy

azssign ULED = 0O: - -
While(l){ wire FCLE, RST X, LOCKED; f‘eseTgen (j:. IJ"Z“JI“E"? RST_X %Eﬁk’

SMEDRMyFHHRENSEEVRELTNS.

X++

‘ clockgen clkgen(CLE, FCLE, LOQCEED):
dr'aw_do‘r(x, Y. color'); resetgen rstgen (FCLE, [ (3W[O] | SW[1] | 3W[2]) & LOCEED), R3T X):
} II."t***t**#t**#t**************#***t***t***t***t**#t**#t**************t***t***t***t

reg [22:0] cnt:

always B (posedge FCLE or negedge R3T X) hegin
if (!'R3T_X) cnt <= 0:
else cnt <= cnt + 1;

end

reg [6:0] =x; // = location
always [ (posedge cnt[Z2] or negedge BE3T_X) begin

if {(!RST X} begin cnt[22] #/0vHoELT
x <= 0; FALTWSAISEE.

end else begin
X o= x + 1:
erndd
end

wire [Z2:0] color = 3'k111;
wire [6:0] v = 33:

miniled con ledeon(.CLE(FCLE), .R3T X(RE3T X,
LVRAM ADDR({v, x}!), .WVRAM DATA({1'b0O, color}), .WRLM WE(1).,
.LCD_C30(LCD_ <S50, LoD CD(LCD <D,
.LCD_R3TE (LCD_RISTE), .LCD _D(LCD D), .LCD_WRI(LCD_WR)):
endmodule

MieruEMB.v

RRIEXRZ FHRIFH FREBREDEAAH AT LA



FTASA 5 —[E1E%
 File — Open Project %‘
- Z¥Emb¥ISE¥lcdO3¥fpga¥main.xise

lcdO3 (X, £DIcdO2,EFLARE. ChER—XITHRET A.

MieruEMB.v #fREL T, BIE LI, FYMERIZRE LGNSO EIT S [E] R
ERLT B.

FTANSAF —REIROENMERED (CP8)

T EAE BHRTEH EREREM AR T L 70
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MieruEMB System V1.1

FPGA XC3S500E-4VQG100C
- Jotwyya7
- MIPS32ZEMCGEENNMUREHELL, vyl aiil)
- TILFHAY)L, MieruPC-2010D 7Oty HaA7ER—X
- 3bMHz /y8v%
- SRAMakO—5
- I/0arko—3
- Mini-LCDa>FA—5
Mini-LCD ZY-FGD1442701V1
- 128 x 128 pixel, 88 5715—, Video RAM (8KB)
SRAM CY7C1049DV33-10ZSXI
- HB12KB (152 x 8)
MieruEMB System Board V1.1
SEDRAMyFDOEMLT) YL
LED
- DA4IF—EMRTRR, DIFRMYFDENINHFESNTIEFIZHLT, D2[EXSDDEFTAHAAMNT T I HETRLT
Sy

AETEAY BRI BRERENEARSS 2T L) 72



MieruEMB System V1.1 x

Copyright (c) 2008-2011 Arch Lab. Tokyo Institute of Technology,
MieruPC Inc. All rights reserved.

The configuration(.bit) file and the source codes of MieruPC/MieruEMB are
provided to the users for academic, educational or training use. You may modify
and/or redistribute the files within a class, a laboratory, or a training section.
Redistribution beyond such an area and commercial use of the files are strongly
prohibited.

O 74FXaL—3>Dbit 774 )LOMieruPC/MieruEMBD Y —XO—K (&, & 3%
ALF=2A—HIZHL T, HECOHEENTOIRDE=OICIRBETIEDTY. J5RX0
MRE, HEFADEHEIZEY, oD T7MILERZEL, BEHATEXT. CNoDE
BZEBA =774V EOBEMOCEBHBIEZELEINTLET.

4@‘
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MieruEMB System V1.1
e, e — S S SSSSS

File — Open Project
- Z:¥Emb¥ISE¥embOl¥fpga¥fpga.xise

IS LT, PROMIZEEAH.
TAMD SDH—K & SDA—KFPH T4 22 (+E5.
- MieruEMBY R T LIZSDH—KR %1 AL THEE (CP9) @@

SDHh—KETFHTA

<f

RRIXKE FHRIPH FREREMMEAAH DT L
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RER.

- H—/\EtE# serv.arch.cs.titech.ac.jp

15—/ \ETE# (MIPSYDOAFHFIRIR)

- THIUME, NRAT—FZTANLZITER DTSN,

- MIPSHYORBIRIRIE

- BEFEEIIES http://www.arch.cs.titech.ac.jp/mcore/buildroot.html

- /home/share/cad/mipsel-emb/usr/bin/

* mipsel-linux-gcc
mipsel-linux-as
mipsel-linux-Id
mipsel-linux-objdump % &

« H—NIZAT A putty EHEED
- Z:¥Emb¥Exe¥putty¥putty.exe

+ T7AIVERIEIZIE WinSCP Z1{E5
- Z:¥Emb¥Exe¥winscp¥WinSCP.exe

A@‘

RRIXKYE FRIFH FREBREEMEARAAS AT L

Categary

[=]- Sessian

.. LoEging
(=] Terminal
.. e yboard
... Bell
... Features
[=]-- W¥in dowe
... Appearan ce
... Behaviour
... Tran slation
... Belaction

... Colours
= Connection
... Crata

... Prosoy
. Telnet
... Rlogin
[+]- S5H

... Berial

About |

| Basiz options for your PuTTY session

—Specify the destination you want to connect to
Host Mame for IF address] Fort
|5e rwarch.cs titech.acip |22

Connection type:
" Raw " Telnet { Rlogin * 55H  Serial

—Load, sawe or delete a stored session

Saved Sessions

Load
Save |
Delate |

Close window on ext:

i Always " Mewar % Onlyon clean exit

Open Cancel

77



SDA—FDEWNA EMEAETTIE

MieruEMBL AT Ly (MieruPC-2010)
- SRAMZEDBI2ZKBD AL AE)ELTHIA.
- 8MBMDOSDA—F%FI|A.

- BREAESIV)YREIZ, SDA—FNLBI2KBDT—RZ AU AEYIZTOAE—LT, EiT%
FIRY B.

- SDA—FDTOvoH A X%#512BELT, 81~1104FH DT OV IEA VAT [ZOE—.
SDA—E M 5L SPI(Serial Peripheral Interface)®—RICTiRAHL.
Windows 7 / XP

- SDH—FZET74—<YLT, 77A4ILEOE—T 5L,
BEE ZYOIT7AILOT—EE SIZFEDOTAVIMNSKEMESNBEZIENAHSNTINS.

- T=1fZL, ENIZ, E5TRWMGEELNHD. CDJZEIZIE, RDOFET, SDA—F%ZEAELT H (TN
TO7OYVIZEYET—2EETAL) DELHS.
WindowsIZ&EI1T5SDA—FDHHE (27 8v I ~DEZIAH)
- SDA—FMDRSAT &95L, av U RTAVTRTCUTDARURZESED. oA T EEMEADE
VAT LDNIRENSHDT, HIDDEEE.
- cd Z:¥Emb¥Exe¥dd  (http://www.chrysocome.net/dd Mo4 2 AO—KLIz30D)
- $ dd if=master.dat of=¥¥.¥d:
- ZMi&, Windows TEEBYIA—<T VL9 5.

A@‘
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MIPS I (MIPS R3000)
Instruction Set Architecture (ISA)

= Instruction Categories Registers
= Computational
= Load / Store el
= Jump and Branch
= Floating Point
= COprocessor PC
= Memory Management HI
= Special LO
3 Instruction Formats: all 32 bits wide
OP rs rt rd sa funct R format
OP rs rt immediate | format

OP jump target J format

80

Adapted from Computer Organization and Design, Patterson & Hennessy, © 2005



i MIPS Arithmetic Instructions

metic statement
Ss2
Ss2

= MIPS assembly lan
add $t0, Ss
sub St0, $s1,

s Each arithmetic instru

s Each arithmetic instruction fits jn 32
exactly three operands
destination <« souycel

ion perferms, only one operation
its and specifies

0 source2

= Operand order is fixed (destination first)

= Those operands are contained in the
register file ($t0, $s1, $s2) — indicated by $

Adapted from Computer Organization and Design, Patterson & Hennessy, © 2005



MIPS Memory Access Instructions

= MIPS has two basic data transfer instructions for accessing
memory

lw S$St0, 4($s3) # load word from memory
sw S$t0, 8($Ss3) # store word to memory

= [he data is loaded into (lw) or stored from (sw) a register in
the register file

= The memory address — a 32 bit address — is formed by
adding the contents of the base address register to the offset
value

= A 16-bit field is limited to memory locations within a region of +213 or
8,192 words (£21° or 32,768 bytes) of the address in the base register

Adapted from Computer Organization and Design, Patterson & Hennessy, © 2005



MIPS Control Flow Instructions

= MIPS conditional branch instructions:
bne $s0, $sl, Lbl #go to Lbl if $s0#$sl
beq $s0, $sl, Lbl #go to Lbl if $s0=S$sl
= EX: if (i==j) h =1i + j;
bne $s0, $sl, 1bll

add $s3, $s0, S$sl1
Lbll:

= Instruction Format (I format):

op rs rt 16 bit offset

= How is the branch destination address specified?

83

Adapted from Computer Organization and Design, Patterson & Hennessy, © 2005



AEYTYITRI/O

MieruEmb System Tl&, AE< YT FI/O(Memory Mapped I/0) %%
- AEYD)—F, SAD=H D5 (load, store)z A HHzRIZHFI A

- 0x00000 ~ OX7ffff M512KB I£ SRAMDYIEAE!)ZEIY ST
- 0x80000 ~ OX7fffff ¥k EH

- 0x800000 L&, A &Y< vIRI/OIZEIYHT
0x80010C : 1KHz 24/ <
. Ox8001fO.GPIO[O] SAAH S

- Ox8001f1 : GPIOI[1] JLAAH 7
+ 0x8001fc : SWIO] AAYF

- 0x8001fd : SWI[1] AAYF

- 0x8001fe : SW[2] AALIF

- Ox8001ff : GPIN FLAAN

- 0x900000 ~ 0x903fff : LCDAET#A AE! 16KB (1byte/lpixel)
- RRITHL=OIZIE, COMEEBICARNTZ T IELL.
- BRDEL%E (0,0), BT% (127,127) LT, (x,y) DEYVEILDFTRL X ADDR (&, RXTEE
- ADDR = 0x900000 + y*128 + x
~@9‘ - INNAMHEGTEZFAH, -ELERIFZEVNTIEET A=OTRIEVLCDAEZNELS.

84
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MIPSaimE Y7 —XTIF v

MIPS Reference Card ZE[fl
- Z:¥Emb¥Doc¥mipsref.pdf

7D EZBICKAHFEDEE
- Z:¥Emb¥SDK/asm D AB%
H— /NGt E#®D /home/username/Emb/SDK/asm IZaE—

Putty ICTH—/\EtE#ICOT 1>
- ¢d ~/Emb/SDK/asm/001_dot/

- emacs, Vi GETIFAILERE, /1)L
(Windows L THRELT, H—/N\HE#(zaF—LTHOK)

4@‘

RRIXKYE FRIFH FREBREEMEARAAS AT L
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001 _dot: Fyh&EE<T OIS L

H—/NETEBIZT
- c¢d ~/Emb/asm/001_dot/

- make A< KRIZT, init.bin NERKEINS.

MieruEMBIZTEF)

H—/\FTERIZT

- make dump T, A7z HOMFT

WinSCP T init.bin ZSDA—FKIZaE—

- make clean TERLI=771 /L EHEIBR
- make image [EMIPSDOETI7AIL%E

MieruEMBd)SD(: AL AEY
—x KT 5.

- make read (& ELF @"ﬁ*&’@:’mu

memgen [FIRBEAFKEOTOI 5L, I—FIEUT

Z:¥Emb¥SDK¥etc¥memgen¥

AS:E=E"

RRIEXRZ FHRIFH FREBREDEAAH AT LA

Makefile

A R A R R R A
# MieruEME System V1,0 2011-10-01 Arch Lab. TOKYO TECH
A R R R R A

TARGET = init
0BJS = startup.o main.o

CMOPREF = /home/share/cad/mipsel/usr/bin/
MIPSCC = $(CMOPREF)mip=el-linux-goc
MIFSAS = $(CMOPREF)mip=zel-linux-as
MIPSLD = &{CMOPREF)mip=el-linux-1d
OBJOUMP = &{CHMOPREF ) m ip=el-1inux-ob,jdump
MEMGEM = memgen

AFLAGS =

LFLAGS = —-static

LSUFFTHES:

SUFFIXES: Lo .5
A A R R R A

=11
F{MAKEY $(TARGET
F{MAKE) image

F(TARGET) : $(0BJS)
$(MIPSLD) F(LFLAGS) -T stdld.script $(0BJS) -o $(TARGET)

L3,0%
i FMIPSAS) F(AFLAGE) $0A00 f30<F) —o a0 f4(EF

image:
F(MEMGENY —b $(TARGET: 512 > $(TARGET) .bin

cump
$COBJOUMPY -5 $(TARGET)

read
readelf -a F(TARGET)

clean:
rm —f *,0 ¥ log,t=t $(TARGET) F({TARGET;.bin
AR A A A A A A A A R R A A A

86



001 _dot: Fyh&EE<T OIS L

~/Emb/SDK/asm/001_dot/main.S

[@] kterm

AEYANDALTIZELY

Ry bZHE<

sw TlF#%< sb &fFE-

TLEEELN.  —

AR AR R R R R A A R R A R A R R R R A A A
# Sample Program for HieroEMEB System »1.0
S S

SJewt

Aalign 2

Llobl o main

Lent main
main:

.=et norecrcer

li 33, 0=800000 # 33 vram address

li 32,7 # 32 =T {(wuhite)

—> =y 32, 4288 (3 # vram[4288] = T;

# (33 % 128 + 64) = 4288

?J

FL1:
i L1 # while(1);
[glu]s] #
Lend main
main.S

Kbk

Asrtii‘

RRIXKYE FRIFH FREBREEMEARAAS AT L

(@] kterm

AR A A AR AR R R
# Sample Program for MisruEMEB System w1,0
ARAR AR AN AR AR R R

et
L2laobl
LNt
_=tart:
L8t
et

(glas)
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e
Moy e

_=tart
_=tart

norearcer
ot

31, 30 3
32, 30 TRTOLORE%E
33, 30 BEOT#IHAIE .
31 30 EOT#WHLT S
35, 0

36, 30

37, 30

32, 30

39, 0

310, 30

311, 30

317, 30

313, 30

314, 30

315, 30

3168, 30

317, 30

318, 30

319, 30

320, 30

321, 30

327, 30

323, 30

324, 30

325, 30

326, 30

327, 30

328, 30 ’

329, 30 ARAYGRAVEADIE
330, F0 BYNZHEL, Svod
331 80 #EYIZEREL, v

%i F=p, O=TFPO0  # stack pointer B12KE

J
(glu]s]

main # jump to the main

end _start

start.S
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. " o o init: file format elf3Z2—tradlittlenips
N\ —
001_dot: FybzE<T OIS L
— Di=zaz=sembly of =zection .startup:
QOOO000 £ =tart:: I
- nop
43 QO000E21 o e at, zero
[@] kterm g: 00001071 nove w0, zero
3 Q0001821 o e vl, zero
EMTRY { =tart 10 00002021 move al, zero
(_start) 14: 00002821 nave  al,zero
SECTIONS 153 QO003021 Moy e a2, 7ero
r 1cs QO003E21 o e a3, Zero
. 20z Qo004021 Moy e 0, zero
ﬁ?giggﬂgrffﬂmﬂ t | startup.ol . text) 1 Sa: 0004571 nove t1 zero
’ 28z QO005021 Moy e t2, zero
. . 2o QO005E21 Moy e t3, zero
+;T%t : E r {EF' (;‘(} init)) } =0 30:  0000B0Z1 move  t4,zero
* * 34z QO00EE21 t5,
et ) ééEEE?E{ itu%}}t?Ht ; LEnu, linkonce, t, #) g+ 000007 ﬂﬁﬁs tEJEEEE
o B = Joci o 0000TEZL oy e 17T, zero
finid : { KEEP (*(.fini)} } =0 40:  0000B0Z1 move =0, zero
LJodsts 11 *{ rodata rodata,* gou, linkonce,r,®) ) d4:  0000SRZ1 move =1, zero
Jtdata [ #(.tdata .tdata.* .gru,linkonce,td,*) } 48: 00009021 move =2, zero
.thss :{{ *( thss ,thss,* .gnu,linkunce.tb.*} *Ltn:u:lmmn:m} 1 dot OO00SE21 move =3, Zero
Lctors 1 start_ctors = 3 a0y O000anZl Moy e =d, zero
KEEP (*(SORT(,ctors,*¥11) B4 00002521 Moy e =h, Fara
KEER éx(tctupgjj } ES: gggggg%% Moy e SE,ZEPD
end ctors = ,; | mow e =0, Zero
.dtors + { =start_dtors = L3 GO  0000c0Z1 move 13, zero
FeEe GG dors. ) i o e W
Ldtors : .
end_dtors = .3 } B QOa0dE21 move k1, zero
.data + { #{ . data .data.* .gnu,linkonce.d,#®) TD: 0000021 move 2R, Lera
SORT (EDHSTRUETDHS} } Td1 QO00eE21 move =R, Zera
. " Ta: QOooF021 Moy e =8, Tero
‘g9t‘Flt ¢+ 4 *leot.plt) ] Toc:  OOOOFEZL move ra, Zera
T . a0 o d0ooT lui s, 0T
20 = ALIGN(16) + OxT#FO: B4 3ThdffO0 ori  =p,sp, 0xFFOO
-got : % *Eﬁan}bgi} 38: 1000005 b 200 <nain>
* * * ac: Q0000
#(,b== ,b==.¥% ,onu, linkonce.b,#®) - nep
*(COMMOM . ; ; .
} { 3l Sled.SCI“IpT Di=za=z=embly of =ection ,text:
= | |oo000200 <nairy: |
o — . 2T ST lui w1, 0=80
YRR TETART T ILE B 204: 24020007 11 w0, T
208: ach210co =) Wi, 4288 (vl
20 1000FF£F 4] 20c <maint e
make dump ) | 210: 00000000 nop
. ‘ _ AYURIZKYTARTEVTIL
RRIEXEKRE FRIZHE BFREREDMAAAADRT L]



002_bar: h5—/\—%{#EH<TAT S5 L

~/Emb/SDK/asm/002_bar/main.S
BENEDEEEZHIRT D=0, RlEEDvTDRIZIE nop AT HIL.

AR AR R AR R R A AR R A A A A A A A R R R
# Sample Program for MieruEMB System »1.0
AR AR R AR R R A AR R A A A A A A A R R R
Jgext
align 2
2lobl main
ent main

main:
=2t noreorder

1i F3, 0eR00000
1i 33, 16384
1i 365, O

33 = vram address

A
A
A
L1z
=r1l 37, 356, 10 A

= 37, 0033 A

addi 33, 33, 1 A

addi 35, 38, 1 A

bre 35, 35, L1 #

#

J FL1

H

Lend main

@“ main.S

RRIXKYE FRIFH FREBREEMEARAAS AT L




FANSAE— (TP TYEER)

Z¥Emb¥SDK¥asm¥003_night¥main.S %ﬂ
- 002 _bar ERICAHABE. INhaEaRN—XI|ZHRET 5.

TEUTJYEREICT BELIC, FYMERICRFLGEACEEIT HEIBEE
DAC Y

- ELLAZADRIZIEEIET S.

FTALZ AT —DENMERESR (CP10)

T EAE BHRTEH EREREM AR T L 90
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101_dot: Fyb#<T7 0SS L (CEEEMR)

Z:¥Emb¥SDK¥app¥101_dot¥main.c

FEEEEE Sanple Program for MieruEMB System w1,0 L2 LN
R R e e P P e e e R R RS R TS

volatile char #*e_vram = (char®) 0900000 ;

volatile int #*e_time = Eint *%DHEDDlDE;

volatile char *& _gpl = (char#®)0=8001f0; LS
volatile char #*e _gp? = (char®*)0=E001F1; }:EU?JZI\II_{_QE@
volatile char #*e_swl = (char®*)0=E001fc; FODEHDESE
volatile char #*e_sw2? = (char®)0=E001fd;

volatile char #*e_sw3 = (char*)0=E001fe;

volatile char #*e _gin = (char®)0=E001Ff;

f**********************************************************************;

int main{void) {
int = = 83;
int y = 83;

e_vran [=+y¥128] = T; xy CHELERYNEARIZTS.
while{1y;

f**********************************************************************f

_ f@- main.c

RRIXKYE FRIFH FREBREEMEARAAS AT L
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102 bClr' jj7_/\ %*E(j D7‘7A(C|=ln|:|mi)

Z:¥Emb¥SDK¥app¥102_bar¥main.c

JEEEEE Sample Program for MieroEME Suystem w1,0 LR LT
SRR RO O O O R

volatile char *e_vram = (char®)0=E00000;
volatile int #*e_time = (int #*)0=30010c;
volatile char *e_gpl = (char#)0wE001F0;
volatile char *e_gp? = (char#)0wE001f1;
volatile char *e_=wl = (char*) (=E001fc;
volatile char *e_sw? = (char#)0=E001fd;
volatile char *e_=sw3d = (char#)0=3001fe;
volatile char *e_gin = (char*)0=E001ff;

f********************************#**#**#**##**#**##*##**#**##*#******#*f

int main{vaid) {
int =, y;
for{==0; ={127T; =+
for(y=0; y<127; y++)
e_vran [=+y*128] = {(ye>3) & T;

whileg1):

j#**#**##*##**#**##**#**##*##**#**#**##**#**##**#**#**##**#**#**##**#**I

main.c
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103_aba: XFEXRTTHTIAT L (CEEBR)

;xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

static const unsigned char fonts[2][16][8] = |
10,0,0,0,0,0,0,0}1, //A

-

Do OO0 00 O o O 00 O 00 o N o N B o B e e B o N R o s
O O O O o 0 0 O O i i Lo T o N e R B e R e I o O s s s s
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void mylib putc{int =, int y, char c, int color){

int i, .J:

fori{i=0; i<16; i++) 1

forij=0; j<8; j++){
if(fonts[{int) {c="A" 2] [i] [i]} e_vram[{=+i)+{y+ 1) *128] = color;

3
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int main{void) { m i
mulib_putc(D, 0, "A°, Tr;  xy CEELEBMICE 7 ICT, A LLSXFERT.
mulib putc(®, 0, 'B", Ti;
mylib putc(16, 0, A", Z);
while{l);

;xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx;

main.c
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